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Introduction

This chapter gives the login and logout steps for Banner® 9.x. This chapter also provides 
naming conventions for the objects that are currently available in Banner 9.x.

Banner 9.x login

Use the following steps to log in to Banner 9.x.

1. Launch your web browser and enter the URL for Banner 9.x application.

2. Enter your username and password on the Banner 9.x Sign In page.

3. Click Sign In. The Banner Main Menu is displayed.

Bookmark for Banner 9.x applications

If you want to create a bookmark for a Banner 9.x application, use a link without extra 
parameters. For example:

http://yourhostname/yourmodulename/banner.zul?page=mainPage

Banner 9.x logout

Banner 9.x uses cookies and caching. If you do not sign out completely, the next person 
who uses the computer might be able to access your work. It is important that you sign out 
and exit the browser.

Single sign on between INB, SSB, and Banner 9.x

Single sign on (SSO) between Internet-Native Banner (INB), Self-Service Banner (SSB), 
and Banner 9.x applications uses Central Authentication Service (CAS) to provide a 
common authentication mechanism. If you are not using CAS, you must log in to INB, 
SSB, and Banner 9.x separately.

To implement SSO between INB, SSB, and Banner 9.x, the following components must be 
configured:

• The SSO Manager must be installed and configured for authentication with CAS. The 
SSO Manager is a CAS client for INB and SSB that allows CAS-based single sign on 
  6nner 9.x Getting Started Guide | Introduction 
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from Banner 9.x. The SSO Manager is a component of Banner Enterprise Identity 
Services (BEIS) and can be downloaded from the Ellucian Download Center under the 
Banner General product. Refer to the Banner Enterprise Identity Services Installation 
Guide for details.

• The Banner 9.x applications must be configured for authentication with CAS. Refer to 
the CAS Single Sign On Handbook for details.

Note: INB and SSB require the SSO Manger to implement CAS-based 
single sign on. Banner 9.x supports CAS natively and does not require the 
SSO Manager.

INB, SSB, and each Banner 9.x application has its own URL. When you first access one of 
these URLs, you are prompted to log in using CAS. Once that login is successful, you can 
access the other URLs without another login. You can work in INB, SSB, and Banner 9.x, 
accessing each respective URL without multiple logins.

Banner 9.x naming conventions

Some Banner objects are available in Banner 9.x. Other Banner objects must be 
accessed with Banner 8.x. The following sections provide general guidelines for naming 
the objects that are available in Banner 9.x.

Note: If your institution maintains or creates custom Banner 9.x objects, 
you must use established naming conventions. Refer to the 8.x version of 
the Banner General Getting Started Guide for a complete list of Banner 
naming conventions.

Banner 9.x objects have a long name and a short (seven- or eight-character) name. For 
example:

Each short name is built from the following components:

• System ID (one or two characters)

• Module ID (one character)

• Object type code (one character)

• Unique ID (four characters)

The following table shows examples of Banner short names:

Long name: Basic Course Information

Short name: SCACRSE
  7nner 9.x Getting Started Guide | Introduction 
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System IDs

The first component of a Banner object name is a one- or two-character code that 
identifies the primary system associated with the page, report, job, or table. In most cases, 
the system ID is the same as the system indicator on the GTVSYSI table.

The following system IDs are currently available in Banner 9.x:

Some objects with these system IDs are currently available in Banner 9.x. Other objects 
with these system IDs must be accessed with Banner 8.x.

Objects with all other system IDs must be accessed with Banner 8.x.

Module IDs

The second component of a Banner object name identifies the module associated with the 
page, report, job, or table. The following module IDs are currently available in Banner 9.x:

Short 
name System ID Module ID Object type code Unique ID

SCACRSE S 
Student

C 
Catalog

A 
Application

CRSE
Basic Course 
Information

STVRSTS S 
Student

T
Validation page/table

V
Validation page/table

RSTS
Course 
Registration 
Status Code 
Validation

GEAATID G
General

E
Event Management

A
Application

ATID
Event 
Registration

System ID System

G Banner General

S Banner Student

System ID Module ID Module

G E Event Management

U Utility
  8nner 9.x Getting Started Guide | Introduction 
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Some objects with these system/module IDs are currently available in Banner 9.x. Other 
objects with these system/module IDs must be accessed with Banner 8.x.

Objects with all other system/module IDs must be accessed with Banner 8.x.

Object type codes

The third component of a Banner object name identifies the type of page, report, job, or 
table. The following object type codes are currently available in Banner 9.x:

Some objects with these system IDs/type codes are currently available in Banner 9.x. 
Other objects with these system IDs/type codes must be accessed with Banner 8.x.

Objects with all other system IDs/type codes must be accessed with Banner 8.x.

S C Catalog

F Registration/Fee Assessment

G General Student

H Grades/Academic History

I Faculty Load

L Location Management

O Overall

P Person

S Schedule

T Validation page/table

System ID Object type code Description

G A Application page

I Inquiry page

S A Application page

I Inquiry page

Q Query page

V Validation page/table

System ID Module ID Module
  9nner 9.x Getting Started Guide | Introduction 
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Banner 9.x User Interface

This chapter describes the basic navigation and basic components of the Banner® 9.x 
user interface.

Basic navigation

The following sections provide basic navigation tips.

Access and navigate within a page

Use the following steps to access and navigate within a Banner 9.x page.

1. Log in to a Banner 9.x application. Refer to “Banner 9.x login” on page 6 for details.

2. Use the Main Menu to select the product, application, and page.

OR

Use the Go To field on the Main Menu to access a page directly. You can enter all or 
part of the short name or long name.

3. Enter required information in the key block of the requested page.

4. Click Go. 

5. Enter data in additional sections as needed.

6. Click Save.
  10nner 9.x Getting Started Guide | Banner 9.x User Interface 
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Return to the key block

If you are on a page and want to return to the key block to enter new data, click Start 
Over.

Display the Main Menu

If you are on a page and want to display the Main Menu, click the  button between the 
Home button and the bread crumb trail.

Bread crumb trail

A breadcrumb trail, located at the top of the page, shows the path to the current page. You 
can click any item in the bread crumb trail to open the Main Menu.

Notification Center

The Notification Center, located under the bread crumb trail, displays information such as:

• Key block, page, and field error messages (including links to page-level errors)

• System prompts

• Successful save of data

• Autohelp information

• Confidential and deceased messages

• Record-specific messages

• Number of messages to be corrected to continue in the page

The following sample shows an error message in the Notification Center:
  11nner 9.x Getting Started Guide | Banner 9.x User Interface 
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Key block

The first block on most pages contains key information. The key block determines what 
data is entered or displayed on the rest of the page. All information on the page refers to 
the key block. The key block stays on the page as subsequent sections are displayed.

When the cursor is in the key block, enterable fields in the key block are enabled. When 
you leave the key block, enterable fields in the key block are disabled.

Sections

Page are divided into sections that contain additional details for the key information. Each 
section contains related information.

If a section cannot be modified, the phrase (READ ONLY) is displayed next to the section 
name. If a user has a query-only role for an entire page, the phrase (READ ONLY) is 
displayed next to the name of each section.

Sections of data are accessed by scrolling up and down the page. Some sections are 
accessed by using tabs that group information in a meaningful way. Subtabs denote child 
records of a parent or master section.

Buttons

Banner 9.x pages include several buttons.

Go To... button

The Go To... button, located next to the bread crumb trail, provides quick navigation as 
follows:
  12nner 9.x Getting Started Guide | Banner 9.x User Interface 
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Tools button

The Tools button is located next to the Go To... button. Select Tools > View > Item 
Properties to view properties for the current field. The properties that are displayed 
depend on the type of field.

Additional Information button

If supplemental data can be entered for a section, the  Additional Information button 
is displayed next to the section name. An active button is displayed as follows:

• The button is displayed with lines if supplemental data can be entered for the record.

• The button is displayed with a check mark if supplemental data already exists for the 
record.

If supplemental data cannot be entered for a section, the button is not displayed.

Refer to “Supplemental Data Engine” on page 26 for more details.

To access a specific page: Click Go To... and enter the short page name 
(such as SCACRSE) or the long page name (such 
as Basic Course Information). Then click the 
returned page name.

To search for a page: Click Go To... and enter three or more letters of the 
short or long page name. Then click the name of 
the desired page in the list of potential matches.

To go to an open page: Click Go To... > Currently Open. Then click the 
name of the desired page in the list of currently 
open pages.

Note: An icon is displayed next to the name of an 
open page if the page has unsaved changes.

To go to a recently opened page: Click Go To... > Recently Opened. Then click the 
desired page name in the list of recently opened 
pages.

To go to a related page: Click Go To... > Related to Current. Then click the 
desired page name in the list of related pages.

Note: Related pages are the pages that appeared 
in the Banner 8.x Options Menu for page-to-page 
navigation.
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Ba
Insert button

The + Insert button, located at the bottom of some sections, is used to add a record in that 
section.

Collapse and expand buttons

The  and  buttons are alternately located to the left of the section name. Use the  
button to collapse the section. Use the  button to expand the section.

Section navigation buttons

The  Next Section and  Previous Section button are located at the bottom of 

each page. Use the  Next Section button to navigate to the next section of data. Use 

the  Previous Section button to navigate to the previous section of data.

Required fields

An asterisk (*) displayed next to a section name indicates the section contains a field that 
requires a value before you save the record.

An asterisk (*) displayed next to a field name indicates the field requires a value before 
you continue on the page.

Field display options

In sections that have multiple records, you can mouse over a field label to display the  
button next to the field label. This button displays sort options (if available) and a list of 
fields in the section. You can:

• Select the Sort Ascending option (if available) to sort records in ascending order, 
based on the field value.

• Select the Sort Descending option (if available) to sort records in descending order, 
based on the field value.

• Select the check box next to a field name to display the field label in the section, or clear 
the check box next to a field name to remove the field label from the section.

The following example shows the display options for the Source field. You can sort in 
ascending order, sort in descending order, and choose whether the Source and/or 
Agreement Date fields should be displayed.
  14nner 9.x Getting Started Guide | Banner 9.x User Interface 
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If values for a field can be sorted, an up or down arrow next to the field name indicates the 
current sort order for the field. You can click the field label to reverse the sort order. 

Dates

Each Banner 9.x application has a messages.properties file. Settings in this file 
determine how dates are entered and displayed. If you enter two or more characters for a 
date, Banner uses these settings to auto-complete the date.

Note: If you enter a single, non-numeric value for the date, Banner 9.x 
displays the system date.
  15nner 9.x Getting Started Guide | Banner 9.x User Interface 
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Lookups

The lookup feature allows you to quickly look up a value for a field. The  Lookup button 
next to a field indicates the field has the lookup feature.

As you enter a value in a field that has the lookup feature, a list of potential matches is 
displayed. You can select a value from the lookup results.

You can also click the  Lookup button, enter a filter value, and press Enter to display 
results that match the filter criteria. Select a value and click OK, or double-click a value to 
return the value to the calling page.
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Filtering

You can filter data in a section if there is an active  Filter button next to the section 
name. Use the following steps to filter data in a section.

1. Click the active  Filter button for the section.

2. Choose the field you want to filter from the Select a field... drop-down list.

3. Choose an operator from the Contains drop-down list.

The available operators depend on the type of field (numeric, alphanumeric, date, 
check box, or other). For example, the Contains operator is available for 
alphanumeric and other fields only.

The Between operator includes the values entered. For example, for codes 
“between” 1 and 5, the values 1, 2, 3, 4, and 5 are considered.

Required fields do not use the Is Null and Is Not Null operators.
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4. Enter a value for the field that you selected.

5. (Optional) If you want to add another field to the filter criteria, choose a field from the 
Add Another Field... field, select an operator, and enter a value for the field that you 
selected. Repeat this step until all filter criteria are entered.

6. (Optional) If you want to remove a filter criteria, click  Remove next to the filter 
criteria.

7. (Optional) If you want to remove all filter criteria, click Clear All. Then re-enter the filter 
criteria.

8. When all filter criteria are entered, click Go to display the filter results.

The number of records retrieved is displayed at the top of the section.

If the results for a field can be sorted, an up or down arrow is displayed next to the 
field name. You can reverse the sort order by clicking the field label.

9. (Optional) If you want to perform another filter, click Filter Again.

10. (Optional) If you want to close the filter and display all unfiltered records, click  
Display all unfiltered results.

Note: The  Display all unfiltered results button is not available on 
pages that open to the Filter Record window.
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Advanced filtering

Advanced filtering is implemented on Banner 9.x query pages. You can perform an 
advanced filter on any fields on these pages. Use the following steps to perform advanced 
filtering.

1. Access a page that uses advanced filtering. The Filter Records section is displayed.

2. For each displayed filter field:

2.1. Choose an operator from the Contains drop-down list.

The available operators depend on the type of field (numeric, alphanumeric, 
date, check box, or other). For example, the Contains operator is available 
for alphanumeric and other fields only.

The Between operator includes the values entered. For example, for codes 
“between” 1 and 5, the values 1, 2, 3, 4, and 5 are considered.

Required fields do not use the Is Null and Is Not Null operators.

2.2. Enter a value for the field.

3. (Optional) If you want to add another field to the filter criteria, choose a field from the 
Add Another Field... field, select an operator, and enter a value for the field that you 
selected. Repeat this step until all filter criteria are entered.

4. (Optional) If you want to remove a filter criteria, click  Remove next to the filter 
criteria.

5. (Optional) If you want to remove all filter criteria, click Clear All. Then re-enter the filter 
criteria.

6. When all filter criteria are entered, click Go to display the filter results.

The number of records retrieved is displayed at the top of the section.

If the results for a field can be sorted, an up or down arrow is displayed next to the 
field name. You can reverse the sort order by clicking the field label.

7. (Optional) If you want to perform another filter, click Filter Again.

8. When you have the results you want, choose a record and click Select to return the 
data to the calling page, or click Cancel to cancel the filter.
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Note: If the page was accessed directly, the Cancel and Select buttons 
are disabled.

Help

Banner 9.x provides online help for pages, fields, and task. Banner 9.x also lists item 
properties for the field where the cursor is currently located.

Online help

Note: Your site administrator installs and configures online help. 
Instructions are contained in the Banner Middle Tier Implementation 
Guide.

Banner online help contains information about the pages, fields, and tasks for a specific 
Banner application. Online help is accessed in a web browser through Banner. 

Help can also be made available offline by downloading a .zip file of online help for a 
Banner application and installing it on your local computer. You can use offline help even 
when you are not connected to Banner.

Help, whether accessed through Banner or locally, for each application includes a .pdf file 
that contains the same information in a print-ready format.

Access online help for the current page

Click  Help in the upper right corner to access online help for the current Banner page.

Browse to another page

When you are in online help, use the following steps to display help for another page in the 
application.

1. Click  in the upper left corner of the help page.

2. Select the Contents tab.

3. Browse to and click the name of the desired page.
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Search for topics

When you are in online help, use the following steps to search online help in the 
application.

1. Click  in the upper left corner of the help page.

2. Select the Search tab.

3. Enter the search string.

4. Click Go.

5. Select the desired page from the displayed list.

Item Properties

Item Properties lists all properties for the field where the cursor is currently located. Item 
properties include the field’s internal database name, whether it is required, type of data 
(character or numeric), and maximum length. The specific properties that are displayed 
depend on the type of field.

To display Item Properties for a field, place the cursor in the field and select Tools > View 
> Item Properties.
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Advanced Features

This chapter describes advanced Banner® 9.x features.

Menu maintenance

The Banner 9.x administrative and self-service menus provide easy access to 
administrative and self-service pages. The following sections give the steps for adding 
menu options to the administrative and self-service menus.

Add a menu option to the administrative menu

The administrative menu lets you select a product, application, and administrative page. 
The following graphic shows an example:

There are two ways to add an option to the Banner 9.x administrative menu.You can 
manually define the display option for a page by using the Object Maintenance 
(GUAOBJS) page, or you can rebuild the menu.

Method 1 - Manually define the display option for a page

Use the following steps to manually define the option that displays a Banner 9.x page on 
the administrative menu.

1. Access the Banner9 Module and Page Maintenance (GUAPAGE) page in Banner 8.x.

2. Verify that the Banner 9.x page is defined on GUAPAGE.
  22nner 9.x Getting Started Guide | Advanced Features 



Ba
3. Access the Object Maintenance (GUAOBJS) page in Banner 8.x.

4. Scroll to or query the Banner 9.x page.

5. Set the Banner8/Banner9 Display Option to one of the following values:

6. Make sure that all parent menus for the page (going back to the Main Menu) have the 
Banner8/Banner9 Display Option set to one of the following values:

All (Banner8 & Banner9)
Banner9 Only

Example: The Basic Course Information (SCACRSE) page is displayed using the 
following menus: Student (*STUDENT) > Course Catalog (*CATALOG). Both the 
*STUDENT and *CATALOG menus need Banner8/Banner9 Display Option set to 
All (Banner8 & Banner9) or Banner9 Only.

7. Save all changes on GUAOBJS.

8. Access the Banner 9.x administrative menu and test the link for the new menu option.

Method 2 - Rebuild the administrative menu

The menu option for a page is added to the Banner 9.x administrative menu when the 
menu is rebuilt. The administrative menu is automatically rebuilt whenever the following 
changes are made:

• An object description is changed on the Object Maintenance (GUAOBJS) page.

• A menu item is changed on the Menu Maintenance (GUTGMNU) page.

The Banner 9.x page must be defined on GUAPAGE before the menu is rebuilt. Based on 
the presence of a GUAPAGE record, the rebuild automatically sets the Banner8/Banner9 
Display Option on GUAOBJS to the correct value for the new page.

After the menu is rebuilt, test the link for the new menu option.

Disable a menu option on the Banner 8.x administrative 
menu

In some cases, the Banner 8.x version of a page is still supported after the page is 
converted to Banner 9.x. Use the following steps if you want to remove the Banner 8.x 
version of the page from the Banner 8.x administrative menu.

1. Access the Object Maintenance (GUAOBJS) page in Banner 8.x.

2. Scroll to or query the page that you want to update.

All (Banner8 & Banner9) Display the menu option on both the Banner 
8.x and Banner 9.x menus.

Banner9 Only Display the menu option on the Banner 9.x 
menu only.
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3. Update the Banner8/Banner 9 Display Option to Banner9 Only.

4. Save all changes on GUAOBJS.

5. Log out of Banner 8.x.

6. Log in to Banner 8.x again.

7. Verify that the administrative menu no longer displays an option for the page.

Add a menu option to the self-service menu

The self-service menu lets you select a select a product, application, and self-service 
page. The following graphic shows an example:

The self-service menu is maintained in Banner Web Tailor. Use the following steps to add 
an option to the self-service menu.

1. Access Banner Web Tailor 8.x.

2. Select Menu Items on the Web Tailor Menu.

3. In the Search by Name field, enter the name of the menu where you want to add the 
menu option.

Example: Enter bmenu.P_MainMnu if you want to add the menu option to the top-
level menu.

4. Click Search.

5. Click the link for the menu name in the list of search results.

6. Click Add a New Menu Item.
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7. Enter the following information on the Create a New Menu Item page:

8. Click Submit Changes.

9. Access the Banner 9.x self-service menu and test the link for the new menu option.

Value-Based Security

Banner’s Value-Based Security (VBS) uses Oracle’s Fine-Grained Access Control 
(FGAC) to provide row-level security to Banner data. VBS includes the following features:

• Security is implemented once and enforced by all products and tools that access the 
database.

• Flexible group rules can be developed and maintained for business profiles and users. 
You can set up and change FGAC security definitions as business practices change. 

• FGAC security applies to all Banner processing, including Banner 9.x administrative and 
self-service applications.

• Users, individual Banner processes, and jobs can be excluded from FGAC security.

• FGAC security rules (predicates) can include one or multiple columns. Oracle table rows 
can also be secured based on column values or other data elements.

Field Description

URL Fully qualified link to the Banner 9.x self-service 
application.

Example:
https://xe.school.edu:8080/SelfService
BannerGeneralEventManagement/ssb/
events

You must enter the full URL. Banner 9.x cannot 
dynamically build the URL due to the different ways that 
applications can be deployed. For example, delivered 
URLs might be renamed, or applications might be 
deployed on different servers.

Note: This requirement for a fully qualified URL applies 
to Banner 9.x only. Banner 8.x dynamically builds URLs, 
so it does not need a fully qualified URL.

Link Text Text that is displayed on the menu for the self-service 
page.

Enabled Checked

Database Procedure Cleared

Submenu Indicator Cleared
  25nner 9.x Getting Started Guide | Advanced Features 



Ba
Banner 8.x pages are used to establish FGAC policy rules on a table, table relationships, 
and user access rules.

If a self-service user has an Oracle username, the database connections is proxied for 
that user. This means that FGAC rules may apply, and the audit trail should reflect the 
actual user. If the user does not have an Oracle username, then FGAC is not in effect.

Supplemental Data Engine

The Supplemental Data Engine (SDE) allows you to store data that is not part of the 
existing Banner data model. The new data is displayed in the Additional Information 
window.

If supplemental data exists for a section of a page, the  Additional Information button 
is displayed next to the section name. The button opens the Additional Information window 
where information can be viewed, edited, or added. When information is added or 
changed, you are prompted to save the changes now or later. You can continue to work on 
the primary page.

The following example shows a sample Additional Information window. Your institution 
defines the data that is entered in this window.

Multi-Entity Processing

Multi-Entity Processing (MEP) is available with Banner 9.x.

Examples

Banner is set up with two institutions: Banner University and Alternate University.
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Scenario 1 - User is assigned to both institutions

When the user logs in, the Multi-Entity Processing window shows both institutions:

The user can take one of the following actions:

• Select one of the institutions, click Ok, and continue to the Main Menu.

• Not select an institution, click Ok, and be logged in to the default institution.

• Click Cancel, and be logged in to the default institution.

The Default indicator identifies the default institution for the user. A user can only have 
one default institution.

Scenario 2 - User is assigned to one institution

When the user logs in, the user is automatically logged in to the assigned institution. The 
header displays the assigned institution.

Scenario 3 - User is not assigned to any institution

When the user logs in, the user is automatically logged in to the default institution.

Institution assignments

The Oracle/Banner VPD Security Maintenance (GSAVPDI) page defines institution 
information:

• The Institution Codes tab shows the institution codes that are defined for an 
installation. The System Default indicator identifies the default institution.

• The User Assignment tab shows all users, their institution assignments, and their 
default or home institution.

If your institution allows cross-institution viewing on specific pages, you can switch 
institutions without leaving the page. Refer to “How to Switch Between Institution Codes” 
in the Multi-Entity Processing Implementation Guide. In Banner 9.x, the (Change) link is 
located in the top right corner of the page.
  27nner 9.x Getting Started Guide | Advanced Features 



Ba
Data masking

Data masking is used to partially or completely obscure data in selected fields.

The GORDMSK table stores application, block, and column information for data masking. 
A Banner 9.x script populates the fields that are used with Banner 9.x. The script can be 
run at any time.

Determine the block ID and the item ID

A masking rule for a Banner 9.x page requires the block ID and item ID for the data that is 
being masked. Use the following steps to determine the block ID and item ID.

1. Log in to Banner 9.x.

2. Access the Banner page where you want to mask data.

3. Navigate to the field to be masked.

4. Select Tools > View > Item Properties.

5. View the displayed values for the block ID and item ID. 

These values will be entered on GORDMSK in the Banner9 Block ID and Banner9 
Item ID fields.

Create a masking rule

The GORDMSK page is used to create masking rules for both Banner 9.x pages and 
Banner 8.x pages. The following instructions apply to masking rules for Banner 9.x pages 
only, not to masking rules for Banner 8.x pages.

The specific steps to mask a field on a Banner 9.x page depend on whether the field is 
already masked on the corresponding Banner 8.x page. The following sections give 
masking steps if the field is not masked in Banner 8.x, and masking steps if the field is 
masked in Banner 8.x.

If the field is not masked in Banner 8.x

Use the following steps to mask a field on a Banner 9.x page if the corresponding Banner 
8.x page does not exist, or if the field is not masked on the corresponding Banner 8.x 
page.

1. Access the Object Maintenance (GUAOBJS) page in Banner 8.x.

2. Verify that the Banner 9.x page is defined on GUAOBJS.

3. Access the Data Display Mask Columns (GORDMCL) page in Banner 8.x.
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4. Verify that the Banner 9.x page has at least one row on GORDMCL. Data in the row 
can be arbitrary, but the following values are recommended if no other row exists:

5. Access the Banner9 Module and Page Maintenance (GUAPAGE) page in Banner 8.x.

6. Verify that the Banner 9.x page is defined on GUAPAGE.

7. Access the Data Display Masking Rules (GORDMSK) page in Banner 8.x.

8. Enter the object code for the Banner 9.x page in the Object field.

9. Go to the next block.

10. Enter the following data for the field that is being masked:

11. Set up other masking criteria as needed (for example, visibility and conceal).

12. Save all changes on GORDMSK.

If the field is masked in Banner 8.x

Use the following steps to mask a field on a Banner 9.x page if the field is already masked 
on the corresponding Banner 8.x page.

1. Access the Banner9 Module and Page Maintenance (GUAPAGE) page in Banner 8.x.

2. Verify that the Banner 9.x page is defined on GUAPAGE.

Field Value

Block Banner9

Item Banner9

Data Type Character

Length 1

Field Description

Block Banner 9 block ID from Banner 9.x Item Properties. 
You can enter a mixed case ID. You can use the list of 
values to populate the field.

Item Banner 9 item ID from Banner 9.x Item Properties. You 
can enter a mixed case ID. You can use the list of 
values to populate the field.

Banner9 Object Name Name from the list of values

Banner9 Block ID Banner 9 block ID. Must match the value in the Block 
field.

Banner9 Item ID Banner 9 item ID. Must match the value in the Item 
field.
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3. Access the Data Display Masking Rules (GORDMSK) page in Banner 8.x.

4. Enter the object code for the Banner 9.x page in the Object field.

5. Go to the next block.

6. Verify that there is a masking rule for the field on the corresponding Banner 8.x page.

The Block field displays the Banner 8.x block ID. The Item field displays the Banner 
9.x item ID.

7. Enter the following data:

8. Set up other masking criteria as needed (for example, visibility and conceal).

9. Save all changes on GORDMSK.

Object maintenance

The following tables and page are used to maintain Banner 9.x objects:

Field Description

Banner9 Object Name Name from the list of values.

Banner9 Block ID Banner 9 block ID from the Banner 9.x Item Properties.

Banner9 Item ID Banner 9 item ID from the Banner 9.x Item Properties.

Object Description

GUBMODU table Stores URLs for Banner 9.x modules. Each module 
requires a fully qualified URL:

http://yourhostname/yourmodulename/

GUBPAGE table Stores Banner 9.x page names, and maps each page to a 
Banner 9.x module.

GOBDOMN table Stores fields in each domain, information for block and 
column names, and component block and column names.

GUAPAGE page Used to create modules and pages and then assign the 
pages to specific modules. An object can exist in only one 
module.
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Security auditing

The following objects are used for Banner 9.x security auditing:

Related pages

The Go To... > Related to Current button displays a list of related pages that a user can 
access from the currently displayed page. Related pages in Banner 9.x are the same as 
the pages that are displayed on the Options Menu in Banner 8.x.

A page must exist in Banner 9.x for it to be displayed on the list of related pages. In 
addition, the related page must be defined on the Options Maintenance (GUAOPTM) page 
in Banner 8.x with an option rule as follows:

• The rule must have a Type Indicator of L (Trigger Calling Form) and a Trigger Name of 
GOTO_Form.

or

• The rule must have a Type Indicator of F (Form).

Data extract

You can extract data from a Banner 9.x page to an Excel spreadsheet (.xls). You can then 
graph and report the extracted Banner data.

Note: This feature is only available on pages that have a key block.

Object Description

GSPSECR package Processes encoded passwords and tracks login data

GOVUROL view Used with security processing

GURLOGN table Stores the number of times the user logs in to the 
application, first login date, and last login date

GSASECR page Stores information on the number of times the user logs in 
to the application, first login date, and last login date.

GSAAUDT page Displays the Banner9 Object Name, Banner9 Block ID, 
and Banner9 Item ID fields

GURWAPP table Stores database specific release numbers

GURWADB table Stores database specific release information
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Enable the data extract option

The data extract option must first be enabled. Use the Data Extract Option field on the 
Object Maintenance (GUAOBJS) page to enable the data extract option for a page. You 
can set the option to extract both key data and detail data, or detail data only. You can 
enable the option on any Banner 9.x page that has a key block.

Extract data

After the data extract option is enabled, use the following steps to extract data on a 
Banner 9.x page.

1. Access the Banner 9.x page that has the data you want to extract.

2. Enter data in the key block.

3. Click Go to display the desired records.

If the data extract option is enabled, the  Data Extract button is enabled.

4. Click  Data Extract to display the Data Extract window.

5. Select Excel Spreadsheet (.xls) as the file format.

6. Click Next.

7. Select that data that you want to extract.

By default, all data are selected. You can clear any check boxes, if you wish.

8. Click Next. to start the extract.

9. After the data is extracted, click Download or view the file.

10. Open the file or save the file as an Excel file (.xls).
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Terminology

This chapter compares Banner® 8.x terminology with Banner 9.x terminology for the 
following languages:

• English

• Spanish

• Portuguese (Brazil)

• Arabic

• French (France)

• French (Canada)

Note: Oracle Forms terminology is not used in Banner 9.x. 

English

The following table compares Banner 8.x terminology with Banner 9.x terminology for an 
English implementation.

Banner 8.x Banner 9.x

General Menu (GUAGMNU) Main Menu

Form Page

Direct Access (Expert Mode) Go To field on the Main Menu

Window (referred to in online help and 
user documentation as main window or 
secondary window)

Pages scroll with all sections included on 
the page or tabbed within the page.

Some windows are still used for alerts 
(such as, Do you want to save your 
changes?) and to default or copy data.

Key block Key block

Block Section, information, data
  33nner 9.x Getting Started Guide | Terminology 



Ba
Next Block • Click Go in the key block to access the 
first section of data.

• Click  Next Section to access the 
next section in order.

• Click Page Down or use the scrollbar to 
access additional sections.

Previous Block • Click  Previous Section to access 
the previous section of data.

• Click Page Up or use the scrollbar to 
access additional sections.

Form tab, subtab Page tab, subtab

Scrollbar Scrollbar

Navigation pane Navigation pane

Field Field; required field has asterisk (*)

Indicator Indicator

Check box Check box

Radio group Radio group

Radio button Radio button

Pulldown Pulldown or dropdown

Button Button

Link Link

Search button  Open Lookup Window button

List of Values/List  Open Lookup Window button

Commit Save button

Rollback Start Over button

Options Menu Go To... > Related to Current button

Option List  Open Lookup Window button for the 
field

Autohint Autohelp (displayed in the Notification 
Center)

Query Filter

Enter Query  Filter button

Execute Query Go in the Filter Records section

Extended Query Advanced filter

Banner 8.x Banner 9.x
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Spanish

La terminología de Oracle ya no se usa en Banner 9.x. Se lista una nueva terminología en 
un formato de "antes y después". Los términos anteriores se listan debajo de Banner 8.x. 
Los nuevos términos se listan debajo de Banner 9.x.

Count Query Hits View results

Wildcard, % or _ Wildcard, % or _

Previous Record Shift + tab or mouse

Next Record Enter or tab or mouse

Clear/Remove Record  Delete button

Insert Record  Insert button at top or bottom of a 
section

Duplicate Record Copy button within a section (for 
example, Copy Term Data button)

Previous Item Shift + tab or mouse

Next Item Enter or tab or mouse

Clear Item Backspace

Duplicate Item  Copy button in a section header

Edit function/Comments button
 Open Multi-Line popup button 

Help (Item Properties) Tools > View > Item Properties

Show Keys Mouse-over tool tips

Data Extract  Data Extract button

Calendar button Calendar button

Supplemental Data (Lightbulb button)  Additional Information button

Banner 8.x Banner 9.x

Menú General (GUAGMNU) Página de Menú Principal

Forma Página

Banner 8.x Banner 9.x
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Acceso Directo (Modo Experto) Campo de Ir a... en la página de Menú 
Principal

Ventana (se hace referencia a ella en la 
ayuda en línea/documentación de usuario 
como principal o secundario)

Las páginas ahora se desplazan con 
todos los bloques y ventanas incluidas en 
la página o se recorre dentro de la página. 

Algunas ventanas se siguen usando para 
alertas (como es, ¿Desea guardar sus 
cambios?) y para predefinir o copiar 
datos.

Bloque Clave Bloque clave

Bloque Sección, Información, Datos

Bloque Siguiente • El botón de Ir desde el bloque Clave, 
dibuja la página y accede a la primer 
sección de datos.

• Use el botón de Flecha Abajo con 
subrayado para ir a la sección siguiente 
de los datos.

• Use Av Pág o desplácese para las 
secciones adicionales de datos.

Bloque Anterior • Use el botón de Flecha Arriba con 
subrayado para ir a la sección anterior 
de datos.

• Use Re Pág o desplácese para las 
secciones adicionales de datos.

Pestaña de Forma, Subpestaña Pestaña de Página, Subpestaña

Barra de Desplazamiento Barra de Desplazamiento

Cuadro de Navegación Cuadro de Navegación

Campo Campo, el campo es requerido si tiene un 
asterisco (*)

Indicador Indicador

Cuadro de elección Cuadro de elección

Grupo Radial Grupo Radial

Botón radial Botón radial

Desplegar Desplegar

Botón Botón

Liga Liga

Botón Buscar El botón Buscar, “…” muestra que la 
búsqueda está disponible para el campo

Banner 8.x Banner 9.x
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Lista de Valores/Lista El botón Buscar, “…” muestra que la 
búsqueda está disponible para el campo

Grabar Botón Guardar

Deshacer Botón Recomenzar

Menú de Opciones Botón Ir a... > seleccionar Relacionado a 
Actual

Lista de Opciones Las opciones se despliegan con la 
búsqueda para el campo

Autosugerencia Autoayuda (desplegada en el Centro de 
Notificación )

Consulta Filtrar

Ingresar Consulta Clic en el botón de Filtro (embudo)

Ejecutar Consulta Clic en Ir en la ventana de Filtro

Consulta Extendida Filtro Avanzado

Conteo de Aciertos Ver resultados

Comodín, % o _ Comodín, % o _

Registro Anterior Shift+Tab o Ratón

Registro Siguiente Intro o Tab o Ratón

Limpiar/Eliminar Registro Clic en el botón Eliminar  (-) en la parte 
superior de la sección.

Insertar Registro Clic en el botón de Insertar  (+) en la 
parte derecha de la sección o botón 
+Insertar al final de la sección.

Duplicar Registro Botón Copiar en la sección de datos 
(Copiar Datos de Periodo, Copiar NRC, 
etc.)

Elemento Anterior Shift+Tab o Ratón

Elemento Siguiente Intro o Tab o Ratón

Limpiar Elemento Retroceso

Duplicar Elemento Clic en el botón de Copiar (doble cuadro) 
en la parte superior derecha de la 
sección.

Función Editar/botón de Comentarios No aplica, las secciones de texto se 
despliegan en las páginas

Ayuda (Propiedades Elementos) Botón de Herramientas > Ver - 
Propiedades de Elementos

Banner 8.x Banner 9.x
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Portuguese (Brazil)

A terminologia da Oracle não é mais usada no Banner 9.x. Uma nova terminologia é 
apresentada abaixo no formato "antes e depois". Os termos anteriores são apresentados 
no Banner 8.x. Os termos novos são apresentados no Banner 9.x.

Mostrar Teclas Sugerencias de herramientas al pasar el 
ratón por encima

Extraer Datos Botón en la esquina superior derecha de 
la sección con la página y flecha derecha

Botón de Calendario Botón de Calendario

 Datos Suplementarios (botón de 
Bombilla) 

Botón de Información Adicional (página 
con líneas) en la sección

Banner 8.x Banner 9.x

Menu Geral (GUAGMNU) Página do Menu Principal

Form Página

Acesso Direto  (Modo Avançado) Campo Ir para... na página do Menu 
Principal

Janela (apresentada na documentação do 
usuário/ajuda online como principal ou 
secundária)

As páginas agora são apresentadas com 
todos os blocos e janelas incluídos na 
página ou tabuladas dentro da página. 

Algumas janelas ainda são usadas para 
alertas (por exemplo, Deseja salvar suas 
alterações?), para predefinir ou copiar 
dados.

Bloco de chaves Bloco de chaves

Bloco Seção, Informações, Dados

Próximo Bloco • O botão Ir no bloco de chaves, desenha 
a página e acessa a primeira seção de 
dados.

• Use o botão Seta para abaixo com 
sublinhado para a próxima seção de 
dados na sequência

• Use a tecla Página para baixo ou Barra 
de rolagem para outras seções de 
dados

Banner 8.x Banner 9.x
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Bloco anterior • Use o botão  Seta para cima com 
sublinhado para voltar à seção de dados

• Use a tecla Página para cima ou a barra 
de rolagem para outras seções de 
dados

Guia Form, Subguia Guia Página, Subguia

Barra de rolagem Barra de rolagem

Painel de navegação Painel de navegação

Campo Os campos com asteriscos são 
obrigatórios (*)

Indicador Indicador

Caixa de seleção Caixa de seleção

Agrupar botão de rádio Agrupar botão de rádio

Botão de rádio Botão de rádio

Pulldown (Suspenso) Pulldown ou Dropdown

Botão Botão

Link Link

Botão Pesquisar O botão Pesquisar, “…” exibe a pesquisa 
que está disponível para o campo

Lista de valores/Lista O botão Pesquisar, “…” exibe a pesquisa 
que está disponível para o campo

Confirmar Botão Salvar

Reverter Botão Reiniciar

Menu de opções Botão Ir para... > selecionar Relacionado 
à atualização

Lista de opções As opções são exibidas fazendo uma 
pesquisa no campo

Dica automática Autoajuda (exibida no Centro de 
Notificação)

Consulta Filtro

Digitar consulta Clique no botão Filtro (funil)

Executar consulta Clique em Ir na janela de Filtro

Consulta estendida Filtro avançado

Resultado da consulta Visualizar resultados

Curinga, % ou _ Curinga, % ou _

Banner 8.x Banner 9.x
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Arabic

Registro anterior Shift+Tab ou Mouse

Próximo registro Enter ou Tab ou Mouse

Apagar/Remover registro Clique no botão Apagar  (-) no canto 
superior direito da seção

Inserir registro Clique no botão Inserir  (+) no canto 
superior direito da seção ou no botão + 
Inserir no canto inferior da seção

Duplicar registro Botão Copiar na seção de dados (Copiar 
dados do período, Copiar CRT etc.)

Item anterior Shift+Tab ou Mouse

Próximo item Enter ou Tab ou Mouse

Apagar item Retrocesso

Duplicar item Clique no botão Copiar (quadrado duplo) 
no canto superior da seção

Função Editar/botão de Comentários Não aplicável, as seções de texto são 
exibidas nas páginas

Ajuda (Propriedades do item) Botão Ferramentas  > Visualizar - 
Propriedades do item 

Exibir teclas Passar o mouse sobre as dicas de 
ferramentas 

Extrair dados Botão no canto superior direito da seção 
com seta para direita e seta para página

Botão Calendário Botão Calendário

Botão Dados complementares 
(Lâmpada)

Botão Informações adicionais (página 
com linhas) na seção

Banner 8.x Banner 9.x
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French (France)

La terminologie Oracle n’est plus utilisée dans Banner 9.x. Toute nouvelle terminologie 
est répertoriée ci-dessous sous la forme avant/après. Les anciens termes sont répertoriés 
sous Banner 8.x et les nouveaux sous Banner 9.x.

Banner 8.x Banner 9.x

Menu général (GUAGMNU) Page de menu principal

Formulaire Page

Accès direct (Mode expert) Aller à... (champ sur la page de menu 
principal)

Fenêtre (en référence à l’aide ou la 
documentation utilisateur en ligne comme 
principale ou secondaire)

Il est maintenant possible de faire défiler 
les pages pour afficher tous les blocs et 
les fenêtres sur la page ou sur les onglets 
de la page.

Certaines fenêtres sont  toujours utilisées 
pour les alertes (par exemple, Voulez-
vous enregistrer vos modifications?) et 
pour  donner une valeur par défaut ou 
copier des données.

Bloc clé Bloc clé

Bloc Section, Informations, Données
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Bloc suivant • Bouton Lancer du bloc clé, la page 
s’affiche et l’utilisateur accède à la 
première section de données

• Utiliser la flèche vers le bas avec 
soulignement pour la section de 
données suivante

• Utiliser Page suivante ou la barre de 
défilement pour accéder aux autres 
sections de données

Bloc précédent • Utilizes la flèche vers le haut avec 
soulignement pour la section de 
données précédente

• Utiliser Page précédente ou la barre de 
défilement pour accéder aux autres 
sections de données

Onglet de formulaire, Sous-onglet Onglet de page, Sous-onglet

Barre de défilement Barre de défilement

Panneau de navigation Panneau de navigation

Champ Champ, champ requis indiqué par 
astérisque (*)

Indicateur Indicateur

Case à cocher Case à cocher

Groupe de boutons radio Groupe de boutons radio

Bouton radio Bouton radio

Menu déroulant Menu déroulant

Bouton Bouton

Lien Lien

Bouton de recherche Bouton de recherche, “…” indique que la 
recherche est disponible pour le champ 

Liste de valeurs/Liste Bouton de recherche, “…” indique que la 
recherche est disponible pour le champ

Valider Bouton Enregistrer 

Retour arrière Bouton Recommencer

Menu Options Bouton Aller à... > cliquer sur Associé(s) 
à actuel 

Liste d’options Les options sont affichées avec la 
recherche pour le champ

Pense-bête automatique Message d’aide automatique (affiché 
dans le centre de notification)

Banner 8.x Banner 9.x
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Recherche Filtre, Filtre rapide

Saisir la recherche Cliquer sur le bouton Filtrer (entonnoir)

Exécuter la recherche Cliquer sur Lancer dans la fenêtre de 
filtre

Recherche étendue Filtre avancé

Compter résultats Afficher résultats

Caractère générique, 
% ou _

Caractère générique, % or _

Enregistrement précédent Maj+tabulation ou souris

Enregistrement suivant Entrée ou tabulation ou souris

Effacer/Supprimer enregistrement Cliquer sur bouton Supprimer (-) en haut 
à droite de la section

Insérer enregistrement Cliquer sur le bouton Insérer (+) en haut à 
droite de la section ou le bouton +Insérer 
en bas de la section

Dupliquer enregistrement Bouton Copier dans la section de 
données (Copier données de semestre, 
Copier NRE, etc.)

Élément précédent Maj+tabulation ou souris

Élément suivant Entrée ou tabulation ou souris

Effacer élément Espacement arrière

Dupliquer élément Cliquer sur bouton Copier (deux carrés) 
en haut à droite de la section

Fonction Éditer/bouton d’observations Sans objet, les sections avec texte sont 
affichées sur les pages

Aide (Propriétés d’élément) Bouton Outils > Afficher – Propriétés 
d’élément

Afficher touches Infobulles qui s’affichent lors d’un survol 
souris

Extraire données Bouton en haut à droite de la section avec 
page et flèche vers la droite

Bouton Calendrier Bouton Calendrier

Données supplémentaires (Bouton 
Ampoule)

Bouton Informations supplémentaires 
(page avec lignes) sur la section

Banner 8.x Banner 9.x
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French (Canada)

La terminologie Oracle n’est plus utilisée dans Banner 9.x. Toute nouvelle terminologie 
est répertoriée ci-dessous sous la forme avant/après. Les anciens termes sont répertoriés 
sous Banner 8.x et les nouveaux sous Banner 9.x.

Banner 8.x Banner 9.x

Menu général (GUAGMNU) Page de menu principal

Formulaire Page

Accès direct (Mode expert) Aller à... (champ sur la page de menu 
principal)

Fenêtre (en référence à l’aide ou la 
documentation utilisateur en ligne comme 
principale ou secondaire)

Il est maintenant possible de faire défiler 
les pages pour afficher tous les blocs et 
les fenêtres sur la page ou sur les onglets 
de la page.

Certaines fenêtres sont  toujours utilisées 
pour les alertes (par exemple, Voulez-
vous enregistrer vos modifications?) et 
pour  donner une valeur par défaut ou 
copier des données.

Bloc clé Bloc clé

Bloc Section, Informations, Données

Bloc suivant • Bouton Lancer du bloc clé, la page 
s’affiche et l’utilisateur accède à la 
première section de données

• Utiliser la flèche vers le bas avec 
soulignement pour la section de 
données suivante

• Utiliser Page suivante ou la barre de 
défilement pour accéder aux autres 
sections de données

Bloc précédent • Utiliser la flèche vers le haut avec 
soulignement pour la section de 
données précédente

• Utiliser Page précédente ou la barre de 
défilement pour accéder aux autres 
sections de données

Onglet de formulaire, Sous-onglet Onglet de page, Sous-onglet

Barre de défilement Barre de défilement

Panneau de navigation Panneau de navigation

Champ Champ, champ requis indiqué par 
astérisque (*)
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Indicateur Indicateur

Case à cocher Case à cocher

Groupe de boutons radio Groupe de boutons radio

Bouton radio Bouton radio

Menu déroulant Menu déroulant

Bouton Bouton

Lien Lien

Bouton de recherche Bouton de recherche, “…” indique que la 
recherche est disponible pour le champ 

Liste de valeurs/Liste Bouton de recherche, “…” indique que la 
recherche est disponible pour le champ

Valider Bouton Enregistrer 

Retour arrière Bouton Recommencer

Menu Options Bouton Aller à... > cliquer sur Associé(s) 
à actuel 

Liste d’options Les options sont affichées avec la 
recherche pour le champ

Pense-bête automatique Message d’aide automatique (affiché 
dans le centre de notification)

Recherche Filtre, Filtre rapide

Saisir la recherche Cliquer sur le bouton Filtrer (entonnoir)

Exécuter la recherche Cliquer sur Lancer dans la fenêtre de 
filtre

Recherche étendue Filtre avancé

Compter résultats Afficher résultats

Caractère générique, 
% ou _

Caractère générique, % or _

Enregistrement précédent Maj+tabulation ou souris

Enregistrement suivant Entrée ou tabulation ou souris

Effacer/Supprimer enregistrement Cliquer sur bouton Supprimer (-) en haut 
à droite de la section

Insérer enregistrement Cliquer sur le bouton Insérer (+) en haut à 
droite de la section ou le bouton +Insérer 
en bas de la section

Banner 8.x Banner 9.x
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Dupliquer enregistrement Bouton Copier dans la section de 
données (Copier données de session, 
Copier NRC, etc.)

Élément précédent Maj+tabulation ou souris

Élément suivant Entrée ou tabulation ou souris

Effacer élément Espacement arrière

Dupliquer élément Cliquer sur bouton Copier (deux carrés) 
en haut à droite de la section

Fonction Éditer/bouton d’observations Sans objet, les sections avec texte sont 
affichées sur les pages

Aide (Propriétés d’élément) Bouton Outils > Afficher – Propriétés 
d’élément

Afficher touches Infobulles qui s’affichent lors d’un survol 
souris

Extraire données Bouton en haut à droite de la section avec 
page et flèche vers la droite

Bouton Calendrier Bouton Calendrier

Données supplémentaires (Bouton 
Ampoule)

Bouton Informations supplémentaires 
(page avec lignes) sur la section

Banner 8.x Banner 9.x
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Keyboard Shortcuts

Banner® 9.x provides full keyboard navigation capabilities. Keyboard shortcuts are 
provided as mouse-over tool tips. This chapter lists the delivered keyboard shortcuts for 
the following languages:

• English

• Spanish

• Portuguese (Brazil)

• Arabic

• French (France)

• French (Canada)

You can customize key mappings at your institution.

Note: Oracle Forms function keys such as Commit, List, Duplicate Item, 
Edit, and Count Query Hits are not used in Banner 9.x.

English

The following table lists the Banner 9.x keyboard shortcuts for an English implementation.

Function or button Keyboard shortcut

Go To Alt + G

Go Shift + F3

Refresh Alt + 5

Start Over Shift + F2

Copy Term Alt + C

End Term Alt + X

Copy Record/Section Shift + F6

Insert Record Shift + F4

Delete Record Shift + F5

Save Shift + F10

Lookup F9
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Spanish

La navegación con teclado está disponible en Banner 9.x y le brinda capacidades de 
navegación total. Puede personalizar la asignación de las teclas en su institución. Los 
atajos de teclado se proveen por medio de las sugerencias de herramientas cuando se 
pasa el ratón por encima. Aquí están las asignaciones de atajos de teclado para la PC.

Filter Shift + F7

Go (on Filter) Shift + F8

Next Block/Section Page Down

Previous Block/Section Page Up

Next Field Tab

Next Record Down Arrow

Previous Field Shift + Tab

Previous Record Up Arrow

Clear Field Backspace

Export Alt + 9

Expand All/
Collapse All
(on a group)

Alt + F2

Cancel (window) Esc

When the Cancel button is displayed on an open window, 
the Esc key can be used to close the window.

Cancel (page) Not available

Exit Without Application Navigator: Ctrl + Shift + Q

With Application Navigator: Ctrl + Shift + F

Help Without Application Navigator: Alt + F1

With Application Navigator: Ctrl + Shift + L

Item Properties Alt + I

Tools Alt + L

Browse Menu Alt + M

Home Shift + Home (returns to the Main Menu)

Function or button Keyboard shortcut
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Las teclas de función de Oracle como es Grabar, Listar, Duplicar Elemento, Editar y 
Conteo de Aciertos ya no se usan.

Función/Botón Teclado

Acceso Directo Alt + G

Ir a Shift + F3

Iniciar Shift + F2

Copiar Periodo Alt + C

Periodo Fin Alt + X

Copiar registro/sección Shift + F6

Insertar Registro Shift + F4

Eliminar Registro Shift + F5

Guardar Shift + F10

Buscar F9

Ir a Alt + G

Filtro Shift + F7

Ir (en Filtro) Shift + F8

Bloque/Sección Siguiente Av Pág

Bloque/Sección Anterior Re Pág

Campo Siguiente Tab

Registro Siguiente Flecha Abajo

Campo Anterior Shift + Tab

Registro Anterior Flecha Arriba

Limpiar Campo Retroceso

Anular (ventana) Esc

(Cuando una ventana se abre y se despliega 
un botón de Anular, la tecla de Escape se 
puede usar para cerrar la ventana.)

Anular (página) No disponible en este momento

Salir Sin navegador de aplicación: Ctrl + Shift + Q

Con navegador de aplicación: Ctrl + Shift + F

Ayuda Sin navegador de aplicación: Alt + F1

Con navegador de aplicación: Ctrl + Shift + L
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Portuguese (Brazil)

A navegação com o teclado está disponível para o Banner 9.x e oferece total capacidade 
de navegação. Você pode personalizar o mapeamento da tecla em sua Instituição. Os 
atalhos do teclado podem ser acessados passando o mouse sobre as dicas de 
ferramentas. Veja aqui os mapeamentos do atalho de teclas para o computador.

As teclas de função do programa Oracle como Confirmar, Listar, Duplicar item, Editar e 
Resultado da consulta não são mais usadas.

Propiedades de Elementos Alt + I

Herramientas Alt + L

Menú Navegar Alt + M

Inicio Shift + Inicio (regresar a la página Principal)

Função/botão Teclado

Acesso direto Alt + G

Ir Shift + F3

Iniciar Shift + F2

Copiar período Alt + C

Período final Alt + X

Copiar registro/seção Shift + F6

Inserir registro Shift + F4

Apagar registro Shift + F5

Salvar Shift + F10

Pesquisar F9

Ir para Alt + G

Filtro Shift + F7

Ir (no filtro) Shift + F8

Próximo bloco/Seção Page Down

Voltar Bloco/Seção Page Up

Próximo Campo Tab

Próximo Registro Seta para baixo

Función/Botón Teclado
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Arabic

Campo anterior Shift + Tab

Voltar Registro Seta para cima

Apagar Campo Retrocesso

Cancelar (janela) Esc

(Quando uma janela é aberta e o botão 
Cancelar é exibido, a tecla Esc poderá 
ser usada para fechar a janela.)

Cancelar (página) Não disponível neste momento

Sair Sem aplicativo navegador: Ctrl + Shift + Q

Com aplicativo navegador: Ctrl + Shift + F

Ajuda Sem aplicativo navegador: Alt + F1

Com aplicativo navegador: Ctrl + Shift + L

Propriedades do item Alt + I

Ferramentas Alt + L

Menu Navegar Alt + M

Página principal Shift + Home (volta à página Principal)

Função/botão Teclado
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French (France)

La navigation clavier est disponible dans Banner 9.x et offre un éventail complet de 
capacités de navigation. Vous pouvez personnaliser le mappage de votre clavier au sein 
de votre établissement. Les raccourcis-clavier sont indiqués dans des infobulles qui 
s’affichent lors d’un survol souris. Ci-dessous les mappages de raccourcis-clavier pour 
PC.

Les touches de fonctions d’Oracle telles que Valider, Lister, Dupliquer élément, Éditer et 
Compter résultants ne sont plus utilisées.

Fonction/Bouton Raccourci-clavier

Accès direct Alt + G

Lancer Maj + F3

Recommencer Maj + F2

Copier semestre Alt + C

Terminer semestre Alt + X

Copier enregistrement/section Maj + F6

Insérer enregistrement Maj + F4

Supprimer enregistrement Maj + F5

Enregistrer Maj + F10

Rechercher F9

Aller à Alt + G

Filtrer Maj + F7

Lancer (pour filtre) Maj + F8

Bloc/Section suivant Page suivante

Bloc/Section précédent Page précédente

Champ suivant Tabulation

Enregistrement suivant Flèche vers le bas

Champ précédent Maj + tabulation

Enregistrement précédent Flèche vers le haut

Effacer champ Espacement arrière
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French (Canada)

La navigation clavier est disponible dans Banner 9.x et offre un éventail complet de 
capacités de navigation. Vous pouvez personnaliser le mappage de votre clavier au sein 
de votre institution. Les raccourcis-clavier sont indiqués dans des infobulles qui s’affichent 
lors d’un survol souris. Ci-dessous les mappages de raccourcis-clavier pour PC.

Les touches de fonctions d’Oracle telles que Valider, Lister, Dupliquer élément, Éditer et 
Compter résultats ne sont plus utilisées.

Annuler (fenêtre) Éch

(Lorsqu’une fenêtre  est ouverte et qu’un 
bouton Annuler est affiché, la touche 
d’échappement peut être utilisée pour fermer 
la fenêtre.)

Annuler (page) Pas disponible pour l’instant

Quitter Sans navigateur d’application: Ctrl + Shift + Q

Avec navigateur d’application: Ctrl + Shift + F

Aide Without Application Navigator: Alt + F1

With Application Navigator: Ctrl + Shift + L

Propriétés d’éléments Alt + I

Outils Alt + L

Menu Parcourir Alt + M

Accueil Maj + Début (retour page principale)

Fonction/Bouton Raccourci-clavier

Accès direct Alt + G

Lancer Maj + F3

Recommencer Maj + F2

Copier session Alt + C

Terminer session Alt + X

Copier enregistrement/section Maj + F6

Insérer enregistrement Maj + F4

Supprimer enregistrement Maj + F5

Fonction/Bouton Raccourci-clavier
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Enregistrer Maj + F10

Rechercher F9

Aller à Alt + G

Filtrer Maj + F7

Lancer (pour filtre) Maj + F8

Bloc/Section suivant Page suivante

Bloc/Section précédent Page précédente

Champ suivant Tabulation

Enregistrement suivant Flèche vers le bas

Champ précédent Maj + tabulation

Enregistrement précédent Flèche vers le haut

Effacer champ Espacement arrière

Annuler (fenêtre) Éch

(Lorsqu’une fenêtre  est ouverte et qu’un 
bouton Annuler est affiché, la touche 
d’échappement peut être utilisée pour fermer 
la fenêtre.)

Annuler (page) Pas disponible pour l’instant

Quitter Sans navigateur d’application: Ctrl + Shift + Q

Avec navigateur d’application: Ctrl + Shift + F

Aide Without Application Navigator: Alt + F1

With Application Navigator: Ctrl + Shift + L

Propriétés d’éléments Alt + I

Outils Alt + L

Menu Parcourir Alt + M

Accueil Maj + Début (retour page principale)

Fonction/Bouton Raccourci-clavier
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Troubleshooting

This chapter provides troubleshooting information for Banner® 9.x.

Sign in page

When you sign in to Banner 9.x, log out, and sign back in, you might see a blank screen. 
Make sure you are not using a saved bookmark to log in to the application. The browser 
tries to reuse the cookie associated with your session ID and causes this behavior. Use 
the correct URL each time you sign in to the application. You can create a bookmark for 
the main page, but the link should resemble the following example and should not include 
extra parameters.

http://yourhostname/yourmodulename/banner.zul?page=mainPage
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